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Chapter 700

Logrank Tests
(Freedman)
Introduction
This module allows the sample size and power of the logrank test to be analyzed under the assumption of
proportional hazards. Time periods are not stated. Rather, it is assumed that enough time elapses to allow for a
reasonable proportion of responses to occur. If you want to study the impact of accrual and follow-up time, you
should use the one of the other logrank modules also contained in PASS. The formulas used in this module come
from Machin et al. (1997).
A clinical trial is often employed to test the equality of survival distributions for two treatment groups. For
example, a researcher might wish to determine if Beta-Blocker A enhances the survival of newly diagnosed
myocardial infarction patients over that of the standard Beta-Blocker B. The question being considered is whether
the pattern of survival is different.
The two-sample t-test is not appropriate for two reasons. First, the data consist of the length of survival (time to
failure), which is often highly skewed, so the usual normality assumption cannot be validated. Second, since the
purpose of the treatment is to increase survival time, it is likely (and desirable) that some of the individuals in the
study will survive longer than the planned duration of the study. The survival times of these individuals are then
said to be censored. These times provide valuable information, but they are not the actual survival times. Hence,
special methods have to be employed which use both regular and censored survival times.
The logrank test is one of the most popular tests for comparing two survival distributions. It is easy to apply and is
usually more powerful than an analysis based simply on proportions. It compares survival across the whole
spectrum of time, not at just one or two points.
The power calculations used here assume an underlying exponential distribution. However, we are rarely in a
position to assume exponential survival times in an actual clinical trial. How do we justify the exponential
survival time assumption? First, the logrank test and the test derived using the exponential distribution have
nearly the same power when the data are in fact exponentially distributed. Second, under the proportional hazards
model (which is assumed by the logrank test), the survival distribution can be transformed to be exponential and
the logrank test remains the same under monotonic transformations.

Technical Details
In order to define the input parameters, we will present below some rather complicated looking formulas. You
need not understand the formulas. However, you should understand the individual parameters used in these
formulas.
We assume that a study is to be made comparing the survival of an existing (control) group with an experimental
group. The control group consists of patients that will receive the existing treatment. In cases where no existing
treatment exists, the control group consists of patients that will receive a placebo. This group is arbitrarily called
group one. The experimental group will receive the new treatment. It is called group two.
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We assume that the critical event of interest is death and that two treatments have survival distributions with
instantaneous death (hazard) rates, λ1 and λ2 . These hazard rates are an subject’s probability of death in a short
period of time. We want to test hypotheses about these hazard rates.

Hazard Ratio
There are several ways to express the difference between two hazard rates. One way is to calculate the difference,
λ1 − λ2 . Another way is to form the hazard ratio (HR):

HR =

λ2
.
λ1

Note that since HR is formed by dividing the hazard rate of the experimental group by that of the control group, a
treatment that does better than the control will have a hazard ratio that is less than one.
The hazard ratio may be formulated in other ways. If the proportions surviving during the study are called S1 and
S2 for the control and experimental groups, the hazard ratio is given by

HR =

Log ( S 2)
.
Log ( S1)

Furthermore, if the median survival times of the two groups are M1 and M2, the hazard ratio is given by

HR =

M1
.
M2

Each of these expressions for the difference between hazards rates is useful in some situations. There is no one
best way, so you will have to be a little flexible.

Logrank Test
We assume that the logrank test will be used to analyze the data once they are collected. Basing the power
calculations on the logrank test, we arrive at the following formula that gives the power based on several other
parameters:

z1− β =

[

]

HR − 1 N (1 − w)ϕ (1 − S1) + ϕ (1 − S 2) / (1 + ϕ )

(1 + ϕHR)

− z1−α / k

where k is 1 for a one-sided hypothesis test or 2 for a two-sided test, α and β are the error rates defined as usual,
the z’s are the usual points from the standard normal distribution, w is the proportion that are lost to follow up,
and ϕ represents the sample size ratio between the two groups. That is, is p1 is the proportion of the total sample
size that is in the control group, ϕ is given by

ϕ=

1 − p1
p1

Note that the hypothesis being tested is that the hazard rates are equal:

H 0 :λ1 = λ2
This formulation assumes that the hazard rates are proportional. It does not assume that the failure times are
exponentially distributed.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Proportion Surviving 1, Proportion Surviving 2, Sample Size, Alpha, or Power. Under most
situations, you will select either Power or Sample Size.
Select Sample Size when you want to calculate the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment that has already been run.
If you select Survive 1, the search is made for values that are less than S2. Likewise, if you select Survive 2, the
search is made for values that are greater than S1.

Test
One-Sided Test
Specify whether the test is one-sided (checked) or two-sided (unchecked). When a two-sided test is selected, the
value of alpha is divided by two.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal survival curves when in fact the curves are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when you
reject the null hypothesis of equal survival curves when in fact the curves are equal.
Values of alpha must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means
that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that
represents the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

700-3
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Logrank Tests (Freedman)

Sample Size – Total Sample Size
N (Total Sample Size)
The combined sample size of both groups.

Sample Size – Sample Proportions
Proportion in Group 1
The proportion of the sample size (N) that is assigned to the first group. The rest of the patients are assigned to the
second group. When exact values are not available, the number in group one is found by rounding up to the next
integer. The number in group two is found by subtraction.
Proportion Lost During Follow Up
This is the proportion of patients in the trial that are lost to follow-up. Since they are lost, you can never obtain
their outcome. The sample size is inflated to account for this loss using the formula:
N(adjusted) = N/(1-p)
where p is the proportion lost.

Effect Size
S1 (Proportion Surviving in Group 1)
S1 is the proportion of patients belonging to group 1 (controls) that are expected to survive during the study. Since
S1 is a proportion, it must be between zero and one. A value for S1 must be determined either from a pilot study
or from previous studies.
S2 (Proportion Surviving in Group 2)
S2 is the proportion of patients belonging to group 2 (experimental) that are expected to survive during the study.
Since S2 is a proportion, it must be between zero and one.
This value is not necessarily the expected survival proportion under the treatment. Rather, you may set it to that
value that, if achieved, would be of special interest. Values below this amount would not be of interest.
For example, if the standard 1-year survival proportion is 0.2 and the new treatment raises this proportion to 0.3 (a
50% increase in the proportion surviving), others may be interested in using it.
Sometimes, researchers wish to state the alternative hypothesis in terms of the hazard ratio, HR, rather than the
value of S2. Using the fact that
HR = Log(S2)/Log(S1)
we can solve for S2 to obtain
S2 = Exp(Log(S1)HR).
Using this equation, you can determine an appropriate value for S2 from a value for HR.
For example, suppose S1 is 0.4 and you have determined that if the hazard rate is reduced by half, the
improvement is sufficient to justify a change in treatment. The appropriate value for S2 is Exp(Log(0.4)(0.5)) =
0.632.
When you do not have an anticipated value for HR, you can find an estimate base on the Median Survival Times
(M1 and M2) since HR = M1/M2.
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Example 1 – Finding the Power
An experiment has been conducted to test the effectiveness of a new treatment on a total of 100 patients. The
current treatment for this disease achieves 50% survival after two years. The proportion in the treatment group
that survived two years was 0.70. Testing was done at the 0.05 significance level. Even though there was an
increase of 0.20 for 0.50 to 0.70, the logrank test did not reject the hypothesis of equal hazard rates for the two
treatments. Study the power of this test.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Freedman) procedure window by expanding Survival, then clicking on
Legacy Procedures, and then clicking on Logrank Tests (Freedman). You may then make the appropriate
entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
One-Sided Test....................................... Not Checked
Alpha ....................................................... 0.05 0.10
N (Total Sample Size)............................. 50 to 300 by 50
Proportion in Group 1 ............................. 0.5
Proportion Lost During Follow Up ........... 0
S1 (Proportion Surviving in Group 1) ...... 0.5
S2 (Proportion Surviving in Group 2) ...... 0.7

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Power
0.2992
0.4162
0.5267
0.6488
0.6994
0.7989
0.8177
0.8891
0.8934
0.9406
0.9395
0.9690

N
50
50
100
100
150
150
200
200
250
250
300
300

N1
25
25
50
50
75
75
100
100
125
125
150
150

N2
25
25
50
50
75
75
100
100
125
125
150
150

S1
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

S2
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000
0.7000

Hazard Two-Sided
Ratio
Alpha
0.5000
0.0500
0.5000
0.1000
0.5000
0.0500
0.5000
0.1000
0.5000
0.0500
0.5000
0.1000
0.5000
0.0500
0.5000
0.1000
0.5000
0.0500
0.5000
0.1000
0.5000
0.0500
0.5000
0.1000

Beta
0.7008
0.5838
0.4733
0.3512
0.3006
0.2011
0.1823
0.1109
0.1066
0.0594
0.0605
0.0310
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
N is the combined sample size.
N1 sample size in group 1.
N2 sample size in group 2.
S1 is the proportion surviving in group 1
S2 is the proportion surviving in group 2
The Hazard Ratio is the ratio of hazard2 and hazard1. It is Log(S2)/Log(S1).
Alpha is the probability of rejecting a true null hypothesis.
Beta is the probability of accepting a false null hypothesis.
Summary Statements
A two-sided log rank test with an overall sample size of 50 subjects (of which 25 are in group
1 and 25 are in group 2) achieves 30% power at a 0.0500 significance level to detect a
difference of 0.2000 between 0.5000 and 0.7000--the proportions surviving in groups 1 and 2,
respectively. This corresponds to a hazard ratio of 0.5000. The proportion of patients lost
during follow up was 0.0000. These results are based on the assumption that the hazard rates
are proportional.

This report shows the values of each of the parameters, one scenario per row. The values from this table are in the
chart below.

Plots Section

This plot shows the relationship between alpha and power in this example. We notice that for alpha = 0.05, a
power of 0.80 is reached when the sample size is about 200. A power of 90% is reached when the sample size is
250. Hence, we realize that this study should have had at least twice the number of patients that it had.
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Example 2 – Finding the Sample Size
Continuing with our example, the researcher decides that he wants to do it right this time. He believes that if the
survival proportion of the treatment group is 0.6 or better, people will begin to use his treatment. He wants to
know how many subjects he needs.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Freedman) procedure window by expanding Survival, then clicking on
Legacy Procedures, and then clicking on Logrank Tests (Freedman). You may then make the appropriate
entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
One-Sided Test....................................... Not Checked
Power ...................................................... 0.70 to 0.95 by 0.05
Alpha ....................................................... 0.05
Proportion in Group 1 ............................. 0.5
Proportion Lost During Follow Up ........... 0
S1 (Proportion Surviving in Group 1) ...... 0.5
S2 (Proportion Surviving in Group 2) ...... 0.60 0.62 0.64

Output
Click the Calculate button to perform the calculations and generate the following output.

Plots Section

We will consider the chart since that allows us to understand the patterns more quickly. We note that changing S2
from 0.60 (the top line) to 0.62 (the middle line) decreases the sample size requirements by almost half. Our
researcher decides to take a sample of 500 patients. This will achieve almost 80% power in detecting a shift from
0.50 to 0.62 in survivability.
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Example 3 – Validation using Machin
Machin et al. (1997) page 180 gives an example in which S1 is 0.25, S2 is 0.50, the one-sided significance level is
0.05, and the power is 90%. The total sample size is 124. We will now run this example through PASS.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Logrank Tests (Freedman) procedure window by expanding Survival, then clicking on
Legacy Procedures, and then clicking on Logrank Tests (Freedman). You may then make the appropriate
entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
One-Sided Test....................................... Checked
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Proportion in Group 1 ............................. 0.5
Proportion Lost During Follow Up ........... 0
S1 (Proportion Surviving in Group 1) ...... 0.25
S2 (Proportion Surviving in Group 2) ...... 0.50

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
Power
0.9014

N
124

N1
62

N2
62

S1
0.2500

S2
0.5000

Hazard One-Sided
Ratio
Alpha
0.5000
0.0500

Beta
0.0986

PASS also calculated the total sample size to be 124.
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